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1. Highlights of Solid Edge 2022
Solid Edge Help includes videos and activities

To help you learn Solid Edge, the help collection includes a Solid Edge video gallery and an Activities
collection. You can access these resources from the Solid Edge overview landing page, under Learn Solid

Edge 

Sketching usability enhancements

Enhancements were made in 2D and 3D sketching and to the interface to make it easier for new users to
start a sketch, and to identify the sketching tools that are available.

Here are a few examples:

• Improved 2D sketching workflow in assembly and in ordered mode

• Automatic base reference plane display

• Ribbon update for Draw group commands

• Vertical command bar visibility

• Auto-complete for finding commands

• Context toolbar for 2D sketching

• Dimension editing enhancements for 2D and 3D

Dynamic Visualization

Provides a single visual interactive environment that delivers document property analytics for Solid Edge
assemblies. Using Dynamic Visualization, you can interactively view, filter, and generate rules for
querying property information for parts in the active assembly. Temporary color overrides are associated
with each query, and results are displayed real-time in the model.

For more information, see Using Dynamic Visualization to view property information.
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Original assembly Assembly with property filtering rules applied

Red—Purchased parts
Blue—Stainless steel parts
Light Blue—Unfiltered property information

Frame environment enhancements

The Frame environment provides new modeling command options to assist you when splitting,
extending, and trimming frames, as well as new capabilities and commands to connect the frames in a
structural simulation study.

• The new Split intersecting frames option on the Frame Options dialog box automatically splits the
frames where the paths intersect. It also splits the sketch used to create the frames.
For more information, see Splitting intersecting frames.

• With the new Trim/Extend command you can now trim frames to multiple objects, such as faces,
bodies, or planes.
For more information, see Trimming frames.

• When you create a new Solid Edge Simulation study for the frame model, you can now automatically
add the rigid link connectors between beam curves, as well as edit existing connectors.
For more information, see Connector enhancements for frame models.

Subdivision Modeling offers four new commands

Expanding on the capabilities Subdivision Modeling provides you, Solid Edge 2022 offers four new
commands to assist you with creating free-form shapes:

1. Highlights of Solid Edge 2022
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• Align to Curve —Fit the vertices of body cage faces to one or more existing curves or to curves

you interactively sketch.

• Bridge —Create a loft-like feature that connects edges or faces selected on a single cage or two

separate cages.

• Offset —Move or lift multiple faces by a specified offset value.

• Split with Offset —Add detail to a face by offsetting the new faces inward by an amount you

define.

To learn more about Subdivision Modeling, see Introduction to Subdivision Modeling.
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2. Administering Solid Edge

Introducing Floating License Manager

The Solid Edge Floating License Manager enables you to return dynamically checked out add-on
license features, such as XpresRoute and Wire Harness when they are not in use, freeing them for use by
others, all without having to restart Solid Edge. Releasing floating add-on licenses back to the pool of
available licenses makes the most efficient use of the total number of licenses needed at any given time.
For more information, see License management for add-on licenses.

For more information about Solid Edge licenses, see the Solid Edge Installation and Licensing guide.
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3. User interaction changes

Auto-complete for finding commands and components

Command Finder

When you use Command Finder to find a command in the Solid Edge interface, auto-complete suggests
matches for the search text as you type it, and displays the commands in a list. Select a command from

the list, and click  to display the Command Finder dialog box.

For more information, see Find a command with Command Finder.

Component Finder

A new search capability, Component Finder, was added to the top of PathFinder in an assembly. Begin
typing the name of a subassembly or part or sheet metal component that you want to locate in the
assembly feature tree. Automatic completion of the search text finds all available matches in the
document. When you click the instance you want to find, it is located and highlighted in PathFinder and
in the graphics window.
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For more information, see Find a part in an assembly.

Floating graphic windows for multiple monitors

Solid Edge graphic windows can now be detached from the application frame. When detached, you can
position the window where you want it on the same monitor, or you can drag it to a different monitor.
PathFinder is displayed in the model window that is currently active.

This feature is convenient when you want to work with your model in multiple Solid Edge windows set
to different model views, for example, top, right, left, and isometric.

The following new commands are available on the context menu of a document tab in all environments.
Some of these commands are also available in the View tab→Windows group on the ribbon:

• New Floating Window—Creates a new floating window containing the active document.

• Float Window—Detaches a window from the main Solid Edge application frame and floats it.

• Dock to Main—Docks the active floating window to the main Solid Edge application frame.

• Dock All to Main—Docks all floating windows back to the main application window.

3. User interaction changes
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For more information, see Floating Solid Edge windows.

Give us your feedback

We want to hear from you. While you are in Solid Edge, you can let us know what is working well, if you
experience problems with Solid Edge, or if you have ideas for new functionality.

From the top-right of the Solid Edge application window, click the smile or the frown .

Using 1000 characters or less, tell us what you like or what can be improved.

For more information, see Give feedback on Solid Edge and Solid Edge Product Improvement Program.

New shortcut commands in Windows Explorer

Windows File Explorer makes it easier to share and organize data by providing shortcut (right-click)
access to the commands Pack and Go and Broken Links. Now you can perform these commands on the
selected document without having to open the document first in Solid Edge or Design Manager.

Give us your feedback
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For more information, see the help topics, Sharing documents or Search for broken links.

Open page versatility

In addition to accessing recently opened files and folders, you can now create new documents starting
from the Solid Edge Application menu→Open page. This enhancement improves productivity by
eliminating switching between the Open page and the New page.

To learn how to set this page as your default, see Changing the start page in Solid Edge.

3. User interaction changes
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Ribbon update for Draw group commands

The default arrangement of the commands on the Sketching tab→Draw group was updated based on
usability feedback from customers. The most frequently used drawing commands—Line and Circle—
have large-sized icons to aid in locating them, and the less frequently used commands are available from
the adjacent list buttons. To prevent the ribbon from being too long, other drawing commands were
moved to adjacent list buttons.

You can return to the previous ribbon arrangement by selecting the Customize the Ribbon command

, and then on the Ribbon page (Customize dialog box), in the right pane,

selecting one of the following options from the shortcut menu of the commands you want to change:

• Small Button

• Large Button

• Text

• No Text

• Button Options...

For more information, see Control the size of ribbon bar buttons and whether or not they display text, in
the help topic, Customize the ribbon.

Steering wheel rotation enhancements

More rotational controls are available on the steering wheel used in synchronous part, sheet metal,
Subdivision Modeling, and assembly.

Now when you click the 3D steering wheel torus to begin rotation:

• The steering wheel snaps to 90-degree positions.

Ribbon update for Draw group commands
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• You can press+hold the Shift key to rotate in 15-degree increments.

• As before, you can snap to keypoints. Keypoints have precedence over increment snapping.

For more information, see Rotate part geometry using the steering wheel.

Updated File Properties dialog box

The Solid Edge File Properties dialog box is greatly enhanced with new functionality. You can filter the
property values of the selected document using the commands in the ribbon, change property values in
the table, and add or remove custom properties.

3. User interaction changes
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The new interactive dialog box:

• Displays Solid Edge file properties in a vertical format.

• Organizes properties in groups.

• Enables you to print or copy the contents to your clipboard.

• Uses shortcuts commands that control the display of gridlines, identifies read-only information, and
outlines cells containing writeable information.

For more information, see the help topic, File Properties dialog box.

Updated File Properties dialog box
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Vertical command bar visibility

Improvements were made to the interaction of the vertical command bar and PathFinder with the
docking panes. This enhances their visibility in the Solid Edge interface and provides faster access to
these tools.

Note:

You can specify that you want to use the vertical command bar format by selecting the option,
Use vertical docking window form, in Application menu→Settings→Options→Helpers, in the
Command User Interface section.

For more information, see Using the command bar.

3. User interaction changes
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4. Design and manufacturing
enhancements

3D drawing commands in Frame and XpresRoute

In the Frame environment and in the XpresRoute environment for piping and tubing, 3D drawing
commands are now available on the Home tab→3D Draw group. For information about a 3D Draw
command, hover over the command and press F1.

The commands in the 3D Draw group replace the Segment group on the ribbon. However, the
individual commands that were in the Segment group are still available for you to add back to the
ribbon using the Customize dialog box, and in the Choose commands from list, selecting Commands
Not in the Ribbon.

Assembly feature and model override enhancements

The assembly feature and model override functionality has been restructured to align with the part
multi-body modeling framework and commands. This ensures that most of the functionality available in
part features are also available in assembly features. Creating a new assembly feature tree in Solid Edge
2022 contains the new functionality. Legacy assembly features and assembly body elements are not
enhanced, but are still supported.

Enhancements to assembly feature and model override enhancements include:

• Assembly addition commands, such as Extruded Protrusion, Revolved Protrusion, and Fillet Weld,
use the ordered part implementation.

• Assembly removal commands, such as Revolve Cut, Hole, and Round, use the ordered part
implementation.

• The assembly commands, Pattern Assembly Feature (rectangular/circular), Pattern Along Curve
Assembly Feature, and Mirror Assembly Feature, use the ordered part implementation.

• The Assembly Feature Options dialog box is now available in the context of the assembly for the
following commands:

• Cut
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• Revolved Cutout

• Hole

• Round

• Chamfer

• New options on the Assembly Feature Options dialog box create synchronous cuts and treatments,
when possible.

• All command options available in ordered part features are available in assembly features.

• Auto-selection of occurrence bodies in the assembly is enabled based on the interference of the tool
with occurrence's design body for the following commands:

• Cut

• Revolved Cutout

• Hole

• Assembly features can locate, select, or modify external references and internal references.

• You can modify multiple design bodies in the part with an assembly feature such as a cut. Previously,
the cut would only modify the active assembly body defined in a part file.

• You can now use the Text Profile command to create text profiles in the parent local profile of
assembly features.

• Variable table enhancements for assembly features include:

• Assembly features are listed under the Assembly Features group in the variable table.

• The naming for the assembly feature variables will be the same as the part feature naming.

• Assembly features support suppression variables.

• Family of assembly enhancements for assembly features include:

• Assembly features are now supported in family of assemblies.

• Excluding and suppressing assembly features are supported in family of assemblies.

• You can override assembly feature variables in the Alternate Assemblies Table dialog box.

4. Design and manufacturing enhancements
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• PathFinder enhancements for assembly features include:

• Currently supported PathFinder functionality is supported for new assembly features.

• The Dynamic Edit command, from both the shortcut menu and edit bar, is available for assembly
features.

• The display of overridden assembly instances and occurrences indicates that they are overridden
within the context of the assembly.

• You can use the Scroll To command to expand PathFinder to the selected assembly feature. If
needed, the collapsed Assembly Feature collection is expanded.

• You can graphically locate assembly features.

• You can locate assembly features at the current level, either the top-level or in place activated level.

• The selected assembly feature is highlighted in the appropriate color for the feature.

• The selected assembly feature is highlighted in PathFinder.

Assign Capture Fit command

Use the Assign Capture Fit command  to predefine relationships for parts that will be included in

an assembly.

The relationships must be the same for the part you are placing and the target part in the assembly and
you should add them in the same order, with the same group name.

Being able to place parts with predefined relationships increases productivity by decreasing the time and
effort required to place parts.

For more information, see Placing parts with predefined relationships.

Automatic base reference plane display in a 2D sketch

When any 2D drawing command in the Sketch group is started in an empty document, the base
reference planes are displayed automatically so that a new user can easily select a plane for sketching.

Assign Capture Fit command
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New options to control base reference plane display

You can now show or hide the base reference planes using the following options on the Layout tab of
the Customize dialog box.

• Show base reference planes always

• Show base reference planes when starting command

• Do not show base reference plane

For more information, see Layout tab (Customize dialog box).

Capture Fit enhanced

The Capture Fit command now supports:

• Match coordinate relationship as a single relation.

4. Design and manufacturing enhancements
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For more information, see About the Match Coordinate Systems relationship.

• Center Plane relationship

For more information, see About the Center-Plane relationship.

Context toolbar for 2D sketching

In Solid Edge 2022, selecting a 2D sketch element—line, arc, circle, curve, ellipse, conic, or keypoint—
now displays a context toolbar at the cursor, so that you can quickly select frequently needed
commands, without having to locate them on the ribbon.

The context toolbar is displayed in all environments where 2D sketching commands are available:

• Synchronous

• Ordered

• Assembly (assembly modeling and when in-place activated)

• Draft (Draw in View)

Context toolbar for 2D sketching
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The commands on the context toolbar vary with the element you select.

For more information, see Using the 2D sketching context toolbar.

A new option on the Helpers tab in the Solid Edge Options dialog box, Show context toolbar, controls
the display of the context toolbar. The option is selected by default.

Custom properties and variables in user-defined tables

Although user-defined tables are not associative to a drawing view or to a model, you now can reference
custom properties, standard properties, and variables in the table. Information and values derived from
property text are updated when you select the Update All command.

Previously, data entry was completely manual or had to be copied and pasted from other fields.

To enable you to add property text to a user-defined table, the Insert Property Text button  is

available in the following locations when you select the Table command :

• In the Table Properties dialog box, on the Title tab and on the Data tab.

• In direct edit mode, on the Table Format command bar.

4. Design and manufacturing enhancements
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For more information, see the following help topics:

• User-defined tables

• Editing a table directly

• Edit a table cell directly

Decal command enhancements

• The Decal command is now available in the synchronous environment. Previously, the command was
only available in the ordered enviornment.

• Use the new Label decal type to apply an image onto the face relative to the contour of a face.

• The Decal command is now available in assembly so you can place decals on the faces of parts
directly in the assembly.

Decal command enhancements
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Placing the decal within the assembly adds a Decals collector within PathFinder that contains the
decal you placed.
Previously, to add decals to an assembly, you had to place a decal on a part face, save the part, and
then place the part in the assembly.

Dimension editing enhancements for 2D and 3D

To make dimension editing consistent and easier to use for new and existing users alike, the following
changes were made for dimension editing in 2D and 3D environments.

Easier access to dimension editing tools

• In modeling environments and in draft, you can now click anywhere on the dimension line to access
dimension value editing controls, as well as clicking the dimension text.

• In synchronous mode, the Modify button  was added to the dimension toolbars. Click this button

to switch between dimension value editing mode, as shown next,

4. Design and manufacturing enhancements
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and making dimension formatting changes, as shown here:

Identifying driving and driven dimensions

It is easier to identify whether a dimension is driving or driven.

• The lock/unlock /  icons on the dimension editing command bars have a new command name

and tooltip to make it easier to understand how to use it:

Driving/Driven Dimension—Lock to make it a driving dimension value. Unlock to make it a
driven dimension value.

Dimension editing enhancements for 2D and 3D
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• When you click the Driving/Driven Dimension button on one of the dimension editing command
bars, it updates the status of the lock icon on other dimension editing command bars that are
displayed.

• You also can use the shortcut menu of a selected dimension to identify and modify a driving or driven
dimension. The following command names and tooltips were updated:

• Driving Dimension—Modifies a dimension to make it driving.
Selecting this command locks the dimension, so that its value controls other sketch elements. It

also updates the icon on command bars to show that the dimension is locked: .

• Driven Dimension—Modifies a dimension to make it driven.
Selecting this command unlocks the dimension, so that it can be controlled by other sketch

elements. It also updates the icon on command bars to show that the dimension is unlocked: .

Easier to identify extent options for ordered commands

For these commands in the Ordered environment—Extrude, Cut, Revolve, Revolved Cut, and Slot—

the command bar now contains three option buttons to define extent direction rather than two:

The option button (1) One-Sided Extent is not new functionality, but its visibility on the command bar
makes it easier to identify which option is active and to select the extent direction you want to apply.

Previously, one-sided extent was not shown on the command bar, but it was the default mode when you
selected the Finite Extent type and deselected options (2) Non-Symmetric Extent and (3) Symmetric
Extent.

4. Design and manufacturing enhancements
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Enhancements to 3D Curves

The 3D Curve command  in the 3D Sketching environment now provides the same functionality in

part, sheet metal, and assembly documents as the following commands used by XpresRoute to route
paths and path segments, and by Surfacing to create surfaces:

• Keypoint Curve command

• Curve Segment command

With the options added to the 3D Curve command bar, you now can use the 3D Curve command to
route many types of paths, for example:

Enhancements to 3D Curves
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To learn how to use the command, see Create a 3D curve.

Enhancements to 3D sketching

Some commands that were available only for 2D sketching and drawing are now also available in
modeling environments for 3D sketches.

More commands available for 3D sketching

The following drawing and sketching relationship commands are now available on the 3D Sketching tab
in part and sheet metal documents:

• In the 3D Draw group:

• Mirror command 

• Route command 

• Auto-Scale Sketch command 

• Equation Driven Curve command 

• In the 3D Relate group:

• Symmetric command 

• Lock command 

4. Design and manufacturing enhancements
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• Rigid Set command

3D sketching commands available in more design environments

When creating a 3D sketch, the newly added commands listed above are also available on the Home tab
in the following environments:

• Assembly

• Frames

• XpresRoute

Cut, copy, and paste 3D sketch elements

The Cut, Copy, and Paste commands are now supported for all 3D sketch elements in ordered and
synchronous sketches. These commands are available on the shortcut menu of a selected element.

Expanded support for conic curves

The following enhancements were made to support the Sketching tab→Draw group→Curves
list→Conic command . For more information, see Draw a conic curve and Edit a conic curve.

Measure curve length with a smart dimension

You can use the Smart Dimension command to add a dimension that measures the length of a conic
curve.

You can edit the dimension to change the curve length.

Expanded support for conic curves
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Rho value supported in the Variable Table

You can use the Variable Table to define a formula for the Rho value [Rho=(D1)∕(D2)] in a conic curve.
The closer the Rho value is to 1.00, the more elongated is the curve.

Using a conic curve

More drawing and sketching applications enable you to use a conic curve. For example, you can include
a conic in a selection set when using the following commands:

• In the Relate group:

4. Design and manufacturing enhancements
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• Symmetric

• In the Draw group:

• Fill

• Fillet

• Offset

• Convert to Curve

• In the Pattern group:

• Rectangular

• Circular

• In the Dimension group:

• Smart Dimension

• In the Evaluate group:

• Goal Seek

• Area

• In the 2D Measure group:

• Smart Measure

• Distance

• Total Length

Family of assemblies enhancements

Family of assemblies enhancements include:

• There are now separate commands for Populate and Update, which reduces complexity and increases
flexibility. Previously, Populate and Update were combined as a single operation.
For more information, see Populating members.

Family of assemblies enhancements
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• Family of assemblies now supports Undo and Redo in the Alternate Assemblies table, global mode,
and local mode. You can undo and redo actions, such as suppress, unsuppress, add or delete
members, or modify components.
As you perform actions on family members, entries are added to the Undo log.

As you undo selected actions in the Undo log, entries for those entries are added to the Redo log.

You can also undo or redo replace part inside or outside the Alternate Assemblies table.

• Use the new Suppress in all and Unsuppress in all commands to suppress and unsuppress a
component in all members.

• A new Remove Suppress Components command removes suppressed components from
PathFinder. To remove suppressed components, in PathFinder, right-click the assembly and then
click Remove Suppress Components to remove any suppressed components from PathFinder.

• A new Keep Suppress Components command keeps suppressed components in PathFinder. To keep
suppressed components, in PathFinder, right-click the assembly and then click Keep Suppress
Components to keep any suppressed components in PathFinder.

4. Design and manufacturing enhancements
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• The Add Suppression Variable command and Delete Suppression Variable command are available
to suppress components in the assembly environment and the Alternate Assemblies Table.
For more information, see Suppressing and unsuppressing components in an assembly

• You can now selectively update and populate family of assembly members. To do this, clear the
Select member(s) to save option and then select the members that you want to update or populate.

• There is a new Save Option on the include:
If you select the Save Only Source and Active Member (Faster) option and then click Ctrl+S, only
the source and active members are saved.
If you clear the option and press Ctrl+S, all members are saved.
For more information, see Saving members.

Fastener System dialog box enhancements

The Fastener System dialog box has been enhanced to be more user friendly.

• The Add Fastener button now expands the right pane of the dialog box so you can select the
appropriate fastener. You can use the arrow buttons to expand and collapse the pane.

• You can use the Preview in Assembly button to display the fastener component highlighted in green.

• You can now view the list of custom properties and characteristics added with Standard Parts
Administrator.

• You can right-click on a column in the components pane and then click Format to display the Format
Columns dialog box. Use the dialog box to control the display and order of the columns.
You can also click and drag the columns to rearrange the columns within the components pane.

Format accuracy round-off in hole tables

When you place a hole table in draft, you now can set different accuracy round-offs on different holes
based on application requirements. For example, dowel holes may require a finer round-off compared to
threaded holes.

• Previously, a single round off was applied to the entire column, as it is a property of all cells in the
column.

Fastener System dialog box enhancements
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• Now you can change the formatting for hole size round-off, units, and tolerance on one or more
individual cells. You can do this using the Format Values dialog box, which you can open from the
context menu in direct edit mode,

Or by selecting the Format button on the Data tab in the Hole Table Properties dialog box:

For more information, see Hole tables and Editing a table directly.

Frame splitting enhanced

Use the new Split intersecting frames option on the Frame Options dialog box to automatically split
the frames where the paths intersect. It also splits the sketch used to create the frames.

Previously, you had to split all of the intersecting path sketches to split the intersecting frame. Now, you
can use the new option in conjunction with the Single frame for collinear segments option to get the
desired results.
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You can also toggle the combination of which frames you want to split and the frames you want to
remain unsplit.

For more information, see Splitting intersecting frames.

Frame trimming enhanced

You can now trim frames to multiple objects, such as faces, bodies, or planes. Previously, you could
select only one object when trimming frames.

For more information, see Trimming frames.

Generative Design: New solver

A new solver, Topology Optimization for Design (TO4D), replaces Frustum as the underlying engine in
Solid Edge Generative Design.

• If a NVIDIA graphics processing unit (GPU) is available on your computer, the study will use it for faster
optimization when you solve it. If a NVIDIA GPU is not present on the machine, the solver will use
CPU.

• There are now two factor of safety optimization options available in the Generate Study dialog box:

• Yield Stress

• Ultimate Stress

• In the Manufacturing Settings dialog box, the following options were removed:

• Prevent enclosed void creation–This option was no longer needed, as the new solver does not
produce voids.

• Material spreading–Future support for this option is planned.

For more information, start with the Generative Design overview. On the Generative Design tab in
Solid Edge, hover over a command and press F1 to learn more.

Gusset Plate command

Use the Gusset Plate command to create gussets on the faces of selected assembly components.

You can create the plate between planar faces

Frame trimming enhanced
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a cylindrical face and a planar face,

or between cylindrical faces.

Immediate feedback for dimension property changes

The Apply button was added to the Dimension Properties dialog box, so you can make property-related
changes (such as text size, terminator style, round-off, and symbol orientation) to one or more selected
dimensions and immediately see their effect.

4. Design and manufacturing enhancements

4-20  newse What's New in Solid Edge 2022, Solid Edge 2022
© 2021 Siemens



Example:

1. Right-click a dimension and choose the Properties command.

2. In the Dimension Properties dialog box, on the Terminator and Symbol tab, choose a
different terminator type from the Origin type list.

3. Click Apply to see your change.

Previously, you had to save and close the dialog for the changes to be applied.

You can use the Undo command to undo the result of your property edit.

Improved 2D sketching workflow in assembly and in ordered mode

The following workflow enhancements were made for 2D sketching in an assembly and in an ordered
document. For more information, see Draw an ordered sketch of a part.

Skip the Sketch command: Just start sketching.

The 2D drawing commands are now available in an assembly document and in an ordered document to
directly begin sketching a line, circle, or arc with a single click, without first having to select the Sketch
command. This reduces the steps required to begin drawing an ordered sketch. It also makes it more
intuitive for a new user to know how to get started.

The commands were added to the Sketch group in the following locations:

• In Ordered Part and Sheet Metal, on the Home tab.

• When in-place activated from an assembly, on the Home tab and the Sketching tab.

Example:

Now when you open an ordered document, you can click the Home tab→Sketch group→Circle
by Center Point command to directly display the drawing command bar and to choose the sketch
profile plane.

Improved 2D sketching workflow in assembly and in ordered mode
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Previously, you had to:

1. Select the Sketch command to open the Sketch environment.

2. Use the Sketch command bar to define the sketch profile plane.

3. Select the drawing command you want to use.

Add to an existing ordered sketch instead of starting a new one.

Instead of creating a new sketch as shown in the previous example, you also have the option to add to
an existing ordered or assembly sketch. The additional text in PromptBar identifies the expanded
workflow options:

Click on an existing sketch to edit or click on a planar face or reference plane to create a new
sketch. To select a plane change the Create-From options by clicking on the list.

Example:

If you select a sketch element from an existing ordered sketch, that sketch will be edited in the
sketch environment using the selected drawing command.
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In an assembly document, you can only add to sketches in the top-level assembly. When in-place
activated from the assembly, you cannot select sketches from other documents.

Improved performance during derived drawing view update

Support for multi-core drawing view processing, which was introduced in Solid Edge 2020 to speed the
performance of large draft files, is now expanded to provide much faster update for drawing views
derived from other drawing views (for example, section, broken-out section, and auxiliary views).

In the Draft environment, you can enable this capability in the Solid Edge Options dialog box. From the
Application menu, choose Settings→Options→General tab, and select the check box, Enable multi-
core drawing view processing.

For more information, see the help topic, General tab (Solid Edge Options dialog box, Draft
environment).

Internal Components enhancements

Solid Edge 2022 contains many enhancements supporting internal components:

• The Internal Components collector was moved before the Coordinate Systems collector in
PathFinder.

Improved performance during derived drawing view update
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Previously, the Internal Components collector was located immediately before the assembly in
PathFinder. This was confusing because when the Internal Components collector was expanded, it
appeared that the components were actually part of the assembly.

• In the Assembly PathFinder feature tree, when you select an internal component for editing in-place,
the Internal Components Modeling tree is expanded for that component.
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If you open another internal component for editing, then the previous internal component tree is
collapsed, so you can focus on the one currently being edited.
If multiple internal components are open for editing simultaneously, then you can drag a Design
Body from one internal component to another in PathFinder.

Internal Components enhancements
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• You can assign and maintain variables in internal components using these commands on the Tools
tab→Variables group:

• Variables command —Opens the Variable Table, which shows all variables for all internal

components being edited.

• Peer Variables command —Displays the variables for the selected internal component.

• You can assign a material to one or more internal components in the Material Table. With materials

assigned, you can save attributes such as density, and use the Physical Properties command  to

compute and display physical properties (center of mass, center of gravity) of an assembly that
includes internal components, or for the active part or internal component. For more information, see
Apply a material to internal components.

• Internal component properties are now managed through Property Manager . Internal

components are displayed in Property Manager like actual parts and assemblies.
For more information, see Working with internal components.

• You can now create new internal references to internal components in an assembly. These references
are available for commands such as Pattern, Transfer, and Disperse.
Previously, internal references could only be created through import translation.
For more information, see Working with internal components.

• You can now drag internal components into an assembly. When you locate an internal component in
the collector, all the internal references to the internal component highlight.
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After you drag the internal component into the assembly, you can use the Assemble command to
apply relationships between the internal component and one or more target parts in the assembly.

For more information, see Dragging internal components into an assembly.

Internal Components Modeling mode

A new assembly modeling mode, Internal Components Modeling, is available for you to design a part,
sheet metal, or subassembly component as an internal component in the context of an assembly.

Previously, internal components could be created only by importing a non-Solid Edge file.

• You now can create an internal component as a single multibody part using the new Home

tab→Components group→Create Part In-Place list→Create Internal Components command .

• You can add bodies to the newly created internal component using the Edit in-Place button on the
Create Internal Components command bar.

• You can add and edit internal component features using all the modeling commands that are
available on the ribbon in ordered and synchronous part, ordered and synchronous sheet metal, and
in assembly modeling.

• You can use the new  Activate Internal Component command, to activate a different internal

component for editing, without having to close assembly modeling.

• A new shortcut command is available in assembly modeling to show only the features for the active
internal component: Show Body Features Only.
Use this option to focus the PathFinder feature tree on just the internal component you are editing.

Internal Components Modeling mode
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For more information, see Create an internal component in an assembly.

Keyshot support for decals

Support for decals is extended to models rendered using Keyshot. Now, when you render a part or
assembly containing a decal, the decal is displayed in the image.

For more information, see Decal command and Rendering parts and assemblies.

Lofted flange user interface enhanced

The Bending Method page on the Lofted Flange dialog box has been enhanced to provide access to
pre-Solid Edge 2020 functionality.

There are now three options on the tab:

Advanced

This option attempts to create only planar, cylindrical, and conical geometry. This is the default
option.

Bends

This option creates planar plates and cylindrical bends.

Formed

This option provides pre-Solid Edge 2020 functionality, which may create non-planar, non-
cylindrical, non-conical flanges.

New tooltips provide information about each of the three options and bend tables are accurately
calculated for each option.

For more information, see Bending Method page.
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Match Coordinate Systems enhancements

Enhancements to the Match Coordinate Systems command include:

• Use the new Single Coordinate System Constraint option  on the Match Coordinate Systems

command bar to create a match coordinate system as a single relation.

This provides a quick and easy edit method and is useful when editing and redefining the coordinate
system. This relationship is supported in family of assemblies, Assembly Relationship Manager, and
Relationship Assistant.

• You can suppress and unsuppress match coordinate system relationships.

• You can add a suppression variable for match coordinate system relationships. Any changes you make
to the variable are reflected in PathFinder.

• You can see the relationship status and any failed error state in Assembly Relationship Manager.

• Right-click the Match coordinate system relationship and use the Edit Definition command to match
the part to a different coordinate system.

For more information, see Edit a Match Coordinate Systems single relationship.

More update methods for text profiles with property text

When the value of property text used in a text profile is changed, you can select either of the following
commands to update the text profile and the sketches and features where it is used:

• Update Active Level

• Update All Open Documents

Match Coordinate Systems enhancements
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Previously, only the Update All command was available for explicitly updating a text profile.

For more information, see Edit a text profile.

Mixed mesh modeling supported

Solid Edge now supports mixed mesh modeling, where models can contain a mix of mesh and classical
(analytical, spline) geometries. Such geometry can be generated in Solid Edge by mixing classical B-rep
bodies with mesh bodies, or by adding features to mesh bodies output from generative design, or by
importing geometry from other applications that create mixed models.

Solid Edge supports the creation and use of hybrid models in part, sheet metal, assembly, and draft.
Hybrid models offer the precision and design control of classical and analytical elements, while also
integrating mesh, scanned, and facet geometry in a single model.

This enhancement of Solid Edge now provides the following for mixed mesh bodies:

• Mixed bodies are shown as mesh bodies in the PathFinder.

• Basic ordered commands like Extrude, Revolve, and Cut are supported to create mixed bodies.

• Commonly used commands, such as Physical Properties, Measure, Geometry Inspector, and
Optimize, as well as commands in the Dimension group, the Annotation group, and the Analyze
group, are either partially or fully supported.

• The new View tab→Style group→Show Facet Edge  command controls the display of facet

edges within a model. When selected, the command displays the facets; when deselected, the facet
edges are not displayed.
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• Reverse Engineering commands support mixed mesh bodies.

• You can import and export mixed mesh bodies from formats that support mixed bodies, such as
Parasolid and PLM XML.

For more information, see Convergent Modeling.

Multi-edge supports large trim gap

The Multi-Edge Flange command now supports large trim gap values.

Object-action input to 2D sketching commands

For more information about these enhancements, see Using the 2D sketching context toolbar.

Multi-edge supports large trim gap
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Preselect 2D elements

Many commands used in 2D sketching now accept one or more preselected 2D elements as input to the
command you choose next. If any of the selected elements are ineligible as input to a command, they
are removed from the selection set.

Previously, you had to:

1. Select the command.

2. Select one or more elements.

This enhancement applies to all the relationship commands in the Relate group. It also applies to sketch
modification commands, such as Construction, Trim Corner, and Extend to Next, as well as some
commands in the Dimension group and the Distance command on the Measure group.

Example:

Use the Select command to select one or more lines, and then choose the Horizontal/Vertical
command to make the selected lines horizontal or vertical.

Preselect a keypoint

Similarly, you can preselect a 2D profile sketch keypoint as input to the following commands:

• Horizontal/Vertical

• Connect

• Distance Between

• Coordinate Dimension

• Measure group→Distance command

Example:

When the Select command is active, you can select a keypoint on a 2D sketch element as input to
the Connect or Distance Between command. Press F5 or Esc to clear the display of keypoints.

Note:

To turn off this workflow capability for keypoint selection, clear this new option on the Cursor
page (IntelliSketch dialog box): Do not show key points in Select command.
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Open a model from a parts list

You now can directly open the part or assembly model associated with a parts list. The Open command
is available on the context menu of a selected item number row in a parts list, as shown in the following
example.

The Open command also is available from a selected member quantity column in a family of assemblies
parts list, or from any part name in the FOA parts list.

Previously, you were able to highlight every item in the parts list or display a preview window showing
the model associated with an item in the parts list, but you had to double-click the drawing view to open
the model, and then navigate to the part in the assembly.

For more information, see Open a model from a parts list.

Open a model from a parts list
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Ordered modeling and assembly feature commands support mixed
bodies

Solid Edge now provides ordered modeling support for mixed bodies, which are bodies that contain a
combination of both classic and facet geometry.

In ordered mode and in an assembly, the following commands can be used to either create or modify
features on mixed bodies:

• Unite

• Intersect

• Split

• Subtract

• Hole

• Slot

• Thread

• Round (constant radius)

• Chamfer

Note:

The Round and Chamfer commands support mixed mesh modeling, but they create a mesh
face.

• Solid Edge also supports patterning in the mixed mesh bodies. In the following example, a hole was
patterned (A) and a rib was mirrored (B).
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The rib and hole were created on mesh bodies, but the faces created by the pattern and mirror are B-
Rep.

For more information, see Convergent Modeling.

Parts list for a family of assemblies (FOA)

A new command, Family of Assemblies Parts List , is available on the Home tab→Tables group

to create a parts list for all or selected members of a family of assemblies. For more information, see
Create a family of assemblies parts list.

In addition, you can:

• Add item balloons to drawing views of FOA members, and link the item numbers to an existing FOA

parts list. Select the Balloon command  and the new Link to Family of Assemblies Parts List

option on the command bar.

• Create saved settings for your FOA parts list using the options in the Parts List Saved Settings section
on the Drawing View Wizard tab (Solid Edge Options dialog box).

• Specify that when a drawing view of a family of assemblies member is updated, its auto-balloons are
also updated based on the FOA parts list. On the General tab (Drawing View Properties dialog box),
select the Auto-Balloon on next update check box and the new option, Family of Assemblies Parts
List.

Parts list for a family of assemblies (FOA)
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Peer Edge Locate command on by default

The Peer Edge Locate command is now on by default. The command setting (On/Off) is now a user
preference and as such remains set as you specify across Solid Edge sessions.

Previously, the command setting would remain set during a Solid Edge session and would reset to off
when Solid Edge was restarted.

Point clouds

You can now insert scanned point cloud files into an assembly for the purposes of viewing, designing,
and measuring the fit of industrial machinery within the context of a facility or plant.

Solid Edge also provides display management functions and tools to reposition and manipulate a point
cloud, change the color and density of points, and take approximate measurements between points in
the point cloud and model geometry.

The new Tools tab→Assistants group→Reference Point Cloud command  and related capabilities

are available in the Assembly, XpresRoute, Frame, and Electrical Routing environments, with a Solid
Edge Premium license and an active maintenance or subscription agreement.

For more information, see Using point clouds.
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Projection lines to virtual intersection points

When you place a linear dimension to the implied intersection point of 2D geometry, you now can
specify that the projection lines for the two parent edges extend to their virtual intersection point.

A new option on the Lines and Coordinate tab—Projection lines to virtual intersection points—is
available in the dimension properties and dimension style for you to select the projection lines to display.

Previously, the projection lines did not extend to show the virtual intersection points. This display option
is still available as the default option (None):

For more information, see:

• Place a dimension to a virtual intersection point

• Lines and Coordinate tab (Dimension Style and Dimension Properties)

Projection lines to virtual intersection points
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Radiate command

Use the Radiate command  in the synchronous environment to edit the radius of selected coaxial,

cylindrical, conical, toroidal, and spherical faces.

For more information, see Radiate command.

Recognize Holes command supports partial circular cutouts

The Recognize Holes command now identifies partial circular cutouts as hole features.

Previously, only complete circular cutouts were identified as hole features.

Reference plane enhancements

Reference plane unification enhancements between part and assembly include:

• The Tangent Plane command is now available in the assembly environment. Now the list of
commands used to create reference planes is the same for both part and assembly.
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• In assembly, placing a reference plane now places a dimension so you can use the Edit Definition
command to edit the dimension without going into Variable Table.

• The plane names in assembly PathFinder are now the same as they are in part. The name is a generic
name, rather than a name based on the plane type. Previously, in assembly PathFinder the plane
name reflected the plane type. For example, suppose you create a parallel reference plane in
assembly. In PathFinder, the name for that reference plane would be Parallel x.

Note:

The names of existing assembly reference planes do not change.

• The reference plane icons for assembly are now used in PathFinder in both part and assembly to
indicate the reference plane type.

Note:

Synchronous reference planes will use the basic reference plane icon.

• The P hot key is now available when creating a parallel or coincident plane in assembly. Use the P hot
key to select a base reference plane to define the x-axis.

• A new Resize Plane command  on the part reference plane shortcut menu in part PathFinder

changes the size of the reference planes.

Reference plane enhancements
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• Editing reference planes is now consistent between part and assembly. The Edit Definition command
and Dynamic Edit command are available when editing reference planes in part or assembly.

• The reference plane edit handle now displays relative to the selected plane for both part and
assembly.

• Updates have been made to the commands found in the reference plane menus in ordered part,
synchronous part, and assembly.

• The reference plane collector from the part reference plane Edit command has been added to the
assembly reference plane Edit command so you can now change the assembly reference plane type.

• The reference plane icons in drawing views have been updated to be consistent with the icons for
part and assembly.

• Reference planes placed in assembly now use driving dimensions to position the reference plane, as is
done in part. Previously, a variable value drove the position of the reference plane in assembly.

• The icon used in drawing view properties now use the base reference plane icon used in part and
assembly.

• Changes have been made to the display of offset values for the Angled Plane, Parallel Plane, and
Tangent Plane commands.

• The entry in the relationship tree now indicates that a keypoint is used to define the position of the
reference plane. Previously, the entry displayed the value for the reference plane position.

• Clicking the entry in the relationship tree highlights the keypoint that was used to define the
position.

• The value of this entry is no longer displayed.

• The box used to change the value is no longer displayed.
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Reference user profile information in a callout

Property text can now reference three fields on the User Profile page of the Solid Edge Options dialog
box: Name, Initials, and Mailing Address. You can extract this information into a callout or other
annotation to identify which user created and which user modified the file it references. You can use
this feature in draft or model files to show user profile information from the active document and from
assembly components (parts or subassemblies).

Previously, only the Author and Last Author property were available, which display the computer login
name.

You can access the six new properties in the Select Property Text dialog box, in the alphabetized
Properties list. Look for the entries that begin with the label, User Profile.

For descriptions of these properties, see Property Text source list (Source: From Active Document).

Retain frame orientation and origin

Frames being replaced with a new member or frames being added to an existing group retain the
orientation and handle points of the existing group members.

If you add a frame between two frames that are not oriented in the same angle and direction, the frame
is added with zero orientation.

A new Orientation option on the Frames Options dialog box specifies the default orientation for the
frames.

Reference user profile information in a callout
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Retrieve dimensions in a detail view

The Home tab→Dimension group→Retrieve Dimensions  command is now available to use in a

detail view in draft. Previously, this command could only be used in views other than derived and
isometric views.

For more information, see Retrieve dimensions and annotations from the model.

Search 3Dfind.it using a 2D sketch

To save you time in searching for, reconfiguring, or recreating 3D models, you can now search the
3Dfind.it supplier part library based on a 2D sketch.

For more information, see Search by sketch with 3Dfind.it.

Solid Sweep Cutout command enhanced

Use the Place Tool Normal to Surface option on the Solid Sweep Cutout command bar to place

the sweep tool normal to a surface on the circular or round body while creating a swept cutout.

With this option selected, the sweep tool follows the path correctly on the circular body, which results in
a precise swept cutout.

Note:

You should enable this option while working with circular or cylindrical models.

Stacked and skewed fractional dimensions

In a document using the ANSI (inch) template, you now can display fractional dimensions in stacked
format and in skewed format. Previously, only the linear format was available.

4. Design and manufacturing enhancements

4-42  newse What's New in Solid Edge 2022, Solid Edge 2022
© 2021 Siemens



The new formats make it easier to read a nominal value and fraction than when written in linear form.
For example, 1 1/16 can be misread as 11/16.

The following fraction formatting options are available on the Units tab Dimension Properties dialog
box and on the Secondary Units tab, under Fractional Display Style:

• Stacked

• Skewed

• Linear

• Fraction Size

For more information, see Format a fractional dimension.

Standard Parts enhanced

Many enhancements were made to Standard Parts.

• Name changes to the Standard Parts applications include:

• The Standard Parts application that is launched from within Solid Edge is now named Part Finder.

• The Configuration Wizard is now named Parts Management Administrator. Use the Parts
Management Administrator to manually specify the location of the standard parts configuration
folder before using the standard parts.

• The Database Administrator application name is unchanged.

• All Standard Parts application dialog boxes, such as Database Administrator, Parts Management
Administrator, and dialogs launched from Solid Edge frame, piping, and fastener systems now have
command ribbons. Previously these dialog boxes had menus and command toolbars.

Standard Parts enhanced
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• The layout of the Parts Management Administrator has changed, but the options are the same.

• The .SAC file has been replace with a .PMSX file. The Parts Management Administrator is still able to
read the older .SAC file, but will migrate the information to the .PMSX file.

• The Add Parts command workflow has been enhanced:

• Previously, there was one Add Parts command that opened the Add Standard Parts dialog box,
which contained options to add parts from the installation database or from a family of parts.
Those options are now separate commands.

• The Standard Parts Assistant combines the methods for adding user parts, such as adding parts
from an Excel worksheet, from manual data entry, and so on.

• In the new Add Parts command, you can now select multiple parts to add. Previously, you could
only select folders.

• The Upgrade command and Add Parts from Libraries command replace the option to add parts
from the installation database using the Smart Installer.

• The Upgrade command upgrades the existing database or libraries to a newer version.

Note:

This command is only available when a machinery or piping library is installed.

The command is also available when you right-click a category, so you can upgrade only the
selected category.

• The Add Parts from Libraries command can add all or only selected categories from the
installation database.

• The Copy to working folder option in Part Finder now remains selected or cleared, based on the last
state of the dialog box. Previously, after exiting Solid Edge or Part Finder, you had to reselect the
option the next time you opened the dialog box.
The Copy to working folder option and the Use assembly folder as working folder option are now
available on the Parts Management Administrator dialog box, so an administrator can control the
options.

• The Standard Parts library setups have been combined with the Quick setup. Previously, there were
separate setups for machinery and piping, which updated the existing libraries, and one Quick setup,
which installed a new database. Now there is a single setup that adds parts to the existing database
or to an empty database.
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Subdivision Modeling: Align to Curve command

In the Subdivision Modeling environment, you can use the new Align to Curve command  to fit the

vertices of body cage faces to one or more existing curves or to curves you interactively sketch. You can
undo and redo each curve edit until you achieve the desired shape.

Subdivision Modeling: Bridge command

In the Subdivision Modeling environment, you can use the new Bridge command  to create a loft-

like feature that connects edges or faces selected on a single cage or two separate cages.

Subdivision Modeling: Align to Curve command
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Subdivision Modeling: Laminar edge support

Subdivision Modeling now supports the selection of faces that contain laminar (open) edges and
laminar edges with the Move or Rotate command and the Lift option. This capability improves the
general functionality of open cages.

Example:

Red=Laminar faces or edges selected

Yellow=New faces created from laminar edges

When the RED FACES are lifted, no new faces are created where laminar edges exist.

When the RED LAMINAR EDGES are lifted, new faces are created.
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For more information, see Moving and rotating cage elements.

Subdivision Modeling: Offset command

In the Subdivision Modeling environment, you can use the new Home tab→Modify group→Offset

command  to move or to lift multiple faces by a specified offset value.

To add faces that are not coplanar to the selected faces on the cage body, use the Lift option.

Subdivision Modeling: Offset command
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To extend the faces without creating new ones, use the Tip option.

Subdivision Modeling: Split with Offset command

In the Subdivision Modeling environment, you can use the new Split with Offset command  to add

detail to a face by offsetting the new faces inward by a user-defined amount.

This command differs from the Split command, which splits the selected cage face into equal parts.
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Subtract command in assembly enhanced

The Subtract command in the assembly environment has been enhanced to subtract assembly objects
from frames, pipes, gusset plates, and internal components created in Solid Edge 2022 and subsequent
versions.

Note:

The Create Assembly Feature option for the command is disabled for files containing weldment
features created in pre-Solid Edge 2022 versions (legacy files).

To enable the option for pre-Solid Edge 2022 files:

1. Delete all weldment parts and features, such as frames, pipes, and assembly features from
the active assembly.

2. Save the file.

3. Recreate the deleted features.

Symmetric relationship for hole sketch profiles

The Home tab→Relate group→Symmetric command  is available in ordered profile sketches.

Now when you select the Hole command, you can add a symmetric relationship between two hole
circles in the ordered sketch. This enables you to create symmetrically aligned holes within the same
Hole feature.

Subtract command in assembly enhanced
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For more information, see:

• Hole Circle command

• Construct a hole (ordered)

Trim/Extend command in Frames

Use the Trim/Extend command  to trim

or extend a frame
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to a selected face, plane, or body, regardless of the order in which the frames were created.

Note:

This command is disabled for files containing weldment features created in pre-Solid Edge 2022
versions (legacy files).

To enable the command for pre-Solid Edge 2022 files:

1. Delete all weldment parts and features, such as frames, pipes, and assembly features from
the active assembly.

2. Save the file.

3. Recreate the deleted features.

YouTube command enhanced

The View tab→Panes group→YouTube command has been enhanced to launch a new web page where
you can enter your Google credentials. Google no longer supports the launching of embedded
framework from any applications.

The YouTube command is also available on the status bar at bottom-right in the application window:

See YouTube videos in Solid Edge for information about recording, uploading, and searching for YouTube
videos.

Watermark command in Draft

The Home tab→Annotation group→Text→Watermark  command is now available in the Draft

environment.

You can change the availability of the Watermark command by selecting the Show watermarks in
Draft environment check box on the Solid Edge Options dialog box→View tab. This setting also
changes the display of watermarks in the document.

YouTube command enhanced
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While printing draft documents, watermarks can be hidden by deselecting the Include watermarks on
print check box on the print option dialog.

Previously, you had to edit the background and add a text box to create a watermark. These text boxes
could not be hidden when editing or printing.

Note:

You can convert a text box created in a previous release to the new watermark behavior using the
Set text box as watermark option in the Text Box Properties dialog box.

For more information, see Using watermarks

Weld symbol enhancements

The following enhancements were made for weld symbols in draft, part, sheet metal, and assembly.

• Ten weld symbols with symbol treatment options were added for the ISO, DIN, and AWS standards.
The newly added symbols are:

• Double bevel butt (with broad root face) and fillet welds (ISO 2553) and Alternate Representation
• Double bevel butt (with broad root face) and fillet welds (DIN EN15085-3)
• Single-U butt weld with V root (ISO 9692-2)
• Permanent/removable Backing symbol (AWS 2.4)
• Groove Symbol (DIN standard)
• Consumable Insert (ISO 2553)
• Resistance Seam (ISO 2553)
• Resistance Spot (ISO 2553)
• Compound Weld Symbol (AWS 2.4)

• To make them easier to identify at a glance, weld symbols are now arranged in a more horizontal than
vertical layout on the Weld Symbol palette. Tooltips for each symbol identify the name, standard, and
any distinguishing characteristics.

• You now can place a tail note on a weld symbol even if no tail symbol is placed. Use the Tail Note1 or
Tail Note 2 boxes in the Weld Symbol Properties dialog box to add a tail note text. To omit the
symbol, click the None option on the Tail Symbol list.

4. Design and manufacturing enhancements

4-52  newse What's New in Solid Edge 2022, Solid Edge 2022
© 2021 Siemens



• The General tab (Weld Symbol Properties dialog box) now has a Preview pane to show the weld
symbol as you create it.

Weld symbol enhancements
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5. Solid Edge Electrical Routing
enhancements

Assign Terminals command now available in Electrical Routing

The Assign Terminals command is now available in Solid Edge Electrical Routing.

Previously, you could only assign terminals in part files. Now you can assign terminals to assembly
components that may contain a number of parts or subassemblies, such as relays and circuit breakers. In
this way any assembled component can be converted into electro-mechanical component by assigning
terminal information.

Browse to 3DfindIT supported in Harness Wizard

The Browse to 3DfindIT command is now available in the Harness Wizard so you can search for a
component in the 3Dfindit portal, retrieve the component, and populate it in the assembly file in a
single operation.

Currently in the harness wizard, if the component name in the .cmp files matches, the component name
assigned in the part file, the part is populated in assembly.
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If the 3D part is not available, you can download the part from a manufacturer's website, and then
import the .cmp and .con files.

To use the Browse to 3DfindIT command, on the Harness Wizard - Step 2 of 3 dialog box, right click
the component that is not present in the assembly and click Browse to 3DfindIT on the shortcut menu.

After you click the command, the search for the component name begins in the 3Dfind.it portal. Any
matching components displayed. You can then click Send to Solid Edge 2022 to directly populate the
component into the assembly. This is useful if you want to download and save 3D CAD files directly from
the portal, while importing ECAD file formats.

Display of bi-color wires

Solid Edge now supports the display of bi-color wires in Solid Edge Electrical Routing. Previously, wires
were represented by only one color with no way to apply a texture to them. Bi-color wires are very
prevalent in industrial machinery. For example, grounded wires are represented by a yellow wire with a
strip of green.

Several standard bi-color wires have been added to the list of materials in the Wire Properties dialog
box. When you select a bi-color wire, the colors are assigned to the Primary Color and Secondary Color
fields on the Wire Properties dialog box.

Use the Pattern Type field on the dialog box to specify the pattern for the colors on the wire. Solid Edge
supports the following pattern types:
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Pattern type

Single Strip

Helical

Zebra

Dash

For more information, see Displaying bi-color wires.

Harness BOM reports

You can now use the Harness Report dialog box to export a BOM report for a harness assembly in the
Electrical Routing environment. You can save the report to .csv format.

The Harness BOM is a consolidated report consisting of all electrical components and connections in the
harness assembly.

For more information, see Harness Reports dialog box.

Harness BOM reports
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Import and export of X2ML files supported

Solid Edge Electrical Routing now supports the import and export of X2ML files.

To import X2ML files, on the Harness Wizard- Step 1 of 3 dialog box, set the ECAD Application option
to Siemens-Solid Edge Wiring Design to display the Wiring X2ML Document option where you can
browse the X2ML document exported from Siemens-Solid Edge Wiring Design in disconnected mode.

After importing the X2ML file, the components and connections are populated in the assembly and the
harness assembly is created.

To export X2ML files, on the Application menu, point to Save As, then choose Save As ECAD. On the
Save As ECAD dialog box, set the ECAD Application option to Siemens-Solid Edge Wiring Design to
display the Wiring X2ML Document option where you can export the X2ML document for back
annotation of wire lengths to be updated into schematics of Siemens-Solid Edge Wiring Design.

A new Supplier Part Number attribute is added from X2ML. Supplier part number details are available
in the Assign Terminals command for connectors and devices. For wires, cables, bundles it is available
in their respective properties window.

In the Harness Wizard dialog box, you can use supplier part number as search criteria to directly browse
to 3DfindIT portal and download a 3D component on the go.

Mapping component ids with PathFinder

Component IDs or instance names are unique identifiers in 2D applications, such as Solid Edge Wiring
Design. Previously, when this wiring data was imported into Solid Edge, there was no way to display
these component ids in Solid Edge PathFinder.

You can now use the Update with Electrical Component IDs option to map the electrical component id
to the name in PathFinder. When you select Update with Electrical Component IDs, you have the
option to replace or append the component id in Solid Edge PathFinder.

Also, with the addition of the Update with Electrical Component IDs option, you no longer have to
manually assign the occurrence for duplicate component ids.

For more information, see Mapping electrical id components in Solid Edge.

Route along Surface command enhanced

Enhancements to the Route along Surface command include:

• When placing points for routing in the command, you can now select cylindrical faces to route an
harness entity through any cylindrical opening in an assembly.
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You can also route along the edges of the selected surface.

Previously, you could only select faces.

• You can now route physical conductors along a surface.

For more information, see Route along Surface command.

Support favorites list for CMP/CON import

Solid Edge Electrical Routing now supports a favorites list of components when importing CMP/CON files
in unmanaged and Teamcenter-managed mode.

You can specify the location of SE-PreferredElectricalComponents.csv which contains the list of favorite
component names. By default, this location is $:\Program Files\Siemens\Solid Edge 2022 \Preferences
\SE-PreferredElectricalComponents.csv, but you can modify the path. When CMP/CON files are imported,
the CMP file is directed to the preferences file first. If the component name in the CMP file matches the
component name in the favorite list the relevant path is displayed in the harness wizard. To populate the
part in the active assembly, click Populate in the harness wizard.

After the harness wizard operation completes, the component name and path for components which
are manually browsed are written back into the csv file.

Support favorites list for CMP/CON import

What's New in Solid Edge 2022, Solid Edge 2022  newse 5-5
© 2021 Siemens



Note:

If the component is not found in the favorites list, Solid Edge searches the electrical parts folder. If
the component is not found there, you must browse manually for the component.
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6. Modular Plant Design enhancements

Modular Plant Design uses unified libraries during setup

The delivery of Solid Edge Modular Plant Design 2022 uses the new unified standard parts library in the
setup.

For more information, see What's New in Solid Edge Modular Plant Design 2022, located on the
Documents tab in Support Center for 2022.

Smap3D Piping integration with Solid Edge

The Modular Plant Design interface is now fully integrated with the Solid Edge application window. In
the Solid Edge interface:

• A new tab on the Solid Edge command ribbon--Smap3D Piping—contains the Solid Edge Modular
Plant Design commands.

• The Piping window and the P&ID Design To-Do List window are now embedded in the Solid Edge
interface as individual docking panes. You can show and hide these tool panes using the View tab-
>Show group->Panes command.

For information on how to use Solid Edge Modular Plant Design, click the Help button

 in the upper right corner of the Solid Edge Modular Plant Design application window.
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7. Simulation enhancements

Connector enhancements for frame models

Previously when you created a simulation study of a structural frame model, rigid link connectors
between frame members were only generated automatically. Automatic link generation did not consider
all cases where rigid links were needed, such as for disjoint beams. Sometimes rigid links were
generated where they were not needed, but the connectors were not editable.

Solid Edge Simulation now provides several enhancements for creating and modifying rigid link
connectors in frame simulation models:

• When creating a simulation study for a frame model, the Connector Options section of the Create
Study dialog box contains a new option to specify a Maximum rigid link length. This value is used to
generate rigid links between beam curves automatically.

• You can automatically create rigid link connectors on the entire frame model using the improved

Simulation tab→Rigid Links group→Auto command .

Note:

When you open a legacy beam study of a frame model, notice the rigid links that were created
previously with the Auto command are displayed in the Simulation pane. To take advantage of
the enhanced rigid link creation algorithm, we recommend you either create a new study using
the automatic link creation method, or delete the legacy rigid links in your existing study and
recreate them using the Auto command.

• You can manually create rigid links between two beam curves using the new Simulation tab→Rigid

Links group→Manual command .
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Example:

• A new Rigid Links node is now available in the Simulation study navigator pane. Individual rigid links
are also listed in QuickPick.

• You can highlight individual rigid links on the model, and use shortcut commands to Delete or
Rename rigid links.

• For more information, see:

• Rigid link connectors
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• Define rigid links manually

Hydrostatic Pressure load

In Solid Edge Simulation, you can use the new Simulation tab→Structural Loads group→Hydrostatic

Pressure command  to define nonuniform conditions for fluid pressure that varies with depth.

You can apply the Hydrostatic Pressure command in the following types of studies:

• Linear Static

• Linear Buckling

• Steady State Heat Transfer + Linear Static

• Steady State Heat Transfer + Linear Buckling

• Harmonic Response

For more information, see Apply a hydrostatic pressure load.

Note:

Use the Pressure command to define a loading condition of constant pressure.

Simplified meshing for complex parts

Use the new option in the Tetrahedral Mesh dialog box—Body Mesh—to simplify and improve the
mesh for complex parts with intricate bodies. In addition to producing a good quality mesh, it provides
automatic geometry cleanup of small faces and edges.

Previously, you needed to use the Geometry Inspector command to improve the geometry prior to
meshing. Refer to the table for examples of the types of parts that you can now mesh successfully by
selecting the Body Mesh check box.

Hydrostatic Pressure load
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For more information, see the Mesh dialog box.

Von Mises stress plots for frames

Beam Von Mises stress plots are now available in the Simulation Results environment for a frames
model.

Previously in Solid Edge Simulation, the margin of safety for a structural frame model was based on
stresses calculated from Beam Max Combined Stress results (beam tension and beam compression),
which can produce negative values.

7. Simulation enhancements
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Now when you solve a linear static study of a structural frame model, the factor of safety plots for
beams are based on Von Mises stress, which provides a more accurate result.

Two new Von Mises stress plots are also available.

For more information, see Beam stress component plots.

Von Mises stress plots for frames
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8. Data translation enhancements

CAD Direct command

Use the CAD Direct command  to insert non-Solid Edge files directly into Solid Edge assemblies

without translating the files separately. This eliminates the task of translating non-Solid Edge files before
inserting them into an assembly.

To update any changes made to the parent/linked parent file, right-click a CAD Direct component and
use the Update CAD Direct Geometry command.

To break the link between the parent file and any CAD Direct component(s), right-click a CAD Direct
component and use the Break CAD Direct Link command. This makes the Solid Edge geometry
independent of the NX file. If you break the link, the link cannot be reestablished.

For more information, see Inserting files using CAD Direct.

Enhanced PMI support for STEP AP242 exports

You are now able to export a STEP AP242 file with more PMI support, including surface association for
PMI dimensions and annotations.

For more information, see Saving to STEP.

Export and import support for coordinate dimensions

Solid Edge 2D translation now exports and imports linear ordinate dimensions as true dimensions,
which can be modified directly. Previously, ordinate dimensions were translated as AutoCAD blocks.

No new options were added for this enhancement. In Solid Edge, select the following translation
options:

• When exporting a Solid Edge DFT file to DXF or DWG, on the Solid Edge to AutoCAD Translation
Wizard (File Mapping) page (the first translation step), select the option Export Solid Edge
dimensions as AutoCAD dimensions.

• When importing a DXF or DWG file to Solid Edge, on the AutoCAD to Solid Edge Translation Wizard -
Step 2 of 8, select the option Import dimensions as dimensions.
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Note:

In Solid Edge, linear ordinate dimensions are created using the Coordinate Dimension command

.

Import from AutoCAD supports more symbols

Twenty-two new manufacturing symbols were added to the Solid Edge ISO GDT Symbols font in Solid
Edge. Support is now provided for the additional symbols when they are imported from the AutoCAD
AIGDT font file to the 2D Model sheet in 2D Drafting.

The symbols are available in Solid Edge as 2-letter codes in the Select Symbols and Values dialog box.
For a list of all available symbols, see Property text codes.

Save As JT exports surface PMI for inspection

Solid Edge 3D translation now exports to JT format the model PMI annotations and dimensions that are
associated with surfaces and with edges. You can use this information to identify the model surfaces
referenced by the PMI for visual inspection purposes. Surface information is required for creating
inspection pathways in Coordinate Measurement Machine (CMM) software, such as Hexagon's PC-DMIS.

To support this enhancement, two new parameters were added to the JT translation file:

• Export Surface Connections to PMI Annotations and Dimensions
• Export Symmetric Diameter as Standard Diameter dimension

For more information, see:

• Save surface PMI to JT format

• Saving Solid Edge to JT.

Save the surface association of PMI in part files

A new registry switch is available to specify that surface information associated with PMI dimensions
and annotations is saved with part and sheet metal files, as well as the edge information. This makes the
surface data available to applications outside Solid Edge, such as NX, Femap, and Solid Edge CAM Pro.

For more information, see Saving the surface association of PMI in part files.
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9. Solid Edge data management
enhancements

Automatically assign document and revision numbers

You can now automatically assign document and revision numbers to files using Property Manager and
File Properties, in addition to the common property dialog box (CPD). For more information, see Assign
document and revision numbers automatically.

Save as Unmanaged command

When document numbering is enabled in Solid Edge data management (SEDM), the new Save As
Unmanaged command lets you save the active document as unmanaged by not assigning a number
and revision.

For information about Solid Edge data management, see Getting started with Solid Edge data
management.
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10. Teamcenter Integration for Solid Edge
(SEEC)

Software Compatibility

The Teamcenter integration for Solid Edge (SEEC) is compatible with the following:

Solid Edge Teamcenter 12.x Teamcenter 13.x Active Workspace

2022 12.1 13.1 Based on TC compatibility

To see a complete list of software compatibility for Solid Edge 2022 with the Teamcenter integration,
see the Software Field Bulletin for Solid Edge and the Teamcenter Integration. A WebKey is required
to access the site.

Note:

For additional information, see the SEEC_readme.htm.

Teamcenter preferences

The following are either new or updated Teamcenter preferences introduced with this release.

For a full description of each of the preferences, see the Teamcenter Preferences section of the
Teamcenter Integration for Solid Edge (SEEC) Guide for Users and Administrators.

New preferences

SEEC_Enable_3DFindit

Enables functionality for using 3Dfind.it in the Teamcenter-managed environment, including the
use of the commands: Insert Components from 3Dfind.it, Replace Part with 3Dfind.it,
Components by 3Dfind.it, and Search 3Dfind.it. Requires application of the Teamcenter Feature
Package for SE2021 MP1 or later.

SEEC_ProjectID_Default

Defines how the default Project ID is determined when you upload a new document to Teamcenter.
You have the option to use the last Project ID specified as the default ProjectID, or you can choose to
use the Project ID defined in the User Settings dialog box in Solid Edge, Hosted Active Workspace, or
Teamcenter RAC.

SEEC_Dispatcher_JT

Determines when JT files are generated for Teamcenter-managed part (.par) and sheet metal (.psm)
documents. You can choose from values to:
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• Have Solid Edge generate the JT file on upload based on the preference value for
SEEC_Image_Generate_3D.

• Enable Add to Teamcenter and Add to Teamcenter-Interactive to create Dispatcher requests.

• Have Add to Teamcenter and Add to Teamcenter-Interactive use the value of
SEEC_Image_Generate_3D to determine if JTs are generated and uploaded, and enable Solid
Edge to create the Dispatcher request.

• Determine that Solid Edge, Add to Teamcenter, and Add to Teamcenter-Interactive ignore the
value for SEEC_Image_Generate_3D and create the Dispatcher request.

Updated preferences

SEEC_ExpandStructure

Default value is updated to 1. Large assemblies, as defined in Solid Edge Options, expand level-by-
level, providing better performance with reduced resource consumption. This option is
recommended.

Access to 3Dfind.it part library

To save you time in searching for, reconfiguring, or recreating parts, the CADENAS supplier part library is
integrated into Solid Edge and made available to Teamcenter-managed Solid Edge users. You can search
a collection of manufacturer product catalogs using the 3Dfind.it website, insert the part into your
assembly, and then save the part to Teamcenter.

For more information, see Importing manufacturer parts.

Data Management tab

The Data Management tab is now available when you work with unmanaged Solid Edge files with the
Teamcenter integration disabled. The commands on the tab provide easy access to common commands.

Determine the default Project ID

Traditionally, the default Project ID shown in common property dialog boxes (such as the New
Document or Upload Document dialog box) is the Project ID that was last specified. With this release of
Solid Edge, you can set the new preference SEEC_ProjectID_Default to determine if you want to use the
traditional behavior or use the Project ID as specified in User Settings in Solid Edge, Active Workspace, or
Teamcenter RAC.

For more information, see Change the default Teamcenter project.
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Enhanced support for Teamcenter Dispatcher

There are two new enhancements for support of Teamcenter Dispatcher:

• You can defer the generation of JT files for part (.par) and sheet metal (.psm) documents from upload
to Teamcenter, to a Dispatcher-managed request. Use the new Teamcenter preference,
SEEC_Dispatcher_JT to determine when JT files are created, which enhances performance when you
upload multiple files to Teamcenter.

Note:

JT files for assemblies continue to be generated when the assembly is uploaded to Teamcenter.

• When you use the Save as Translation command and save the translated file to either the local disk
or the Item Revision of the translated data set, you can offload the translation and upload process by
generating a Dispatcher request. Use the new Teamcenter preference, SEEC_Dispatcher_Translation
to manage file translation.

For more information, see the Teamcenter Integration for Solid Edge (SEEC) Guide for Users and
Administrators and the readme in the Dispatcher Administrator folder contained in the SEEC feature
package.

Improved expansion of large assemblies

Bill of materials (BOM) expansion of large assemblies is improved for better performance through the
reduction of resource consumption of Teamcenter server processes. To realize the performance
enhancement, the existing Teamcenter preference SEEC_ExpandStructure is now delivered in the SEEC
Feature Package with a default value of 1. Assemblies deemed to be large based on the values defined
in the Solid Edge Options→Assembly Open As page, now expand level-by-level.

The value of the preference is displayed in the BOM Expansion section of the Load Options docking
window, when you open an assembly in Solid Edge.

For a full description of the preference, SEEC_ExpandStructure, see the Teamcenter Preferences section
of the Teamcenter Integration for Solid Edge (SEEC) Guide for Users and Administrators.

Navigation pane

Use the new Navigation pane in the Open File dialog box to expand the folders in Teamcenter and
display the contents in the document display list. The Navigation pane shows all the folders in
Teamcenter to which you have access.

Enhanced support for Teamcenter Dispatcher
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For more information, see Open File dialog box.

New browser support for Hosted Active Workspace

Hosted Active Workspace now supports the use of Chromium-based Microsoft Edge.

For more information, see Configuring hosted Active Workspace.

Project assignment expanded

Previously you could only make project assignments to a Solid Edge document when you uploaded a
document to Teamcenter. Access to project assignment is expanded to be available from the Teamcenter
ribbon. Now you can make single or multiple selection project assignments using the new Assign Project
ID command. When you select documents for assignment to a project, all projects of which you are a
member are available for selection.

For more information, see Assign a Teamcenter project to an item.

Revert to Teamcenter command

A new command, Revert , is available on the Teamcenter tab→Manage group. The command
cancels the check-out from Teamcenter a part or subassembly within an assembly document and then
reloads the latest version from Teamcenter.

Note:

To use the Revert command, the assembly must be saved to cache, but not uploaded to
Teamcenter.

For more information, see Revert documents to the version in Teamcenter.

Structure Editor supports cloned variants

Structure Editor supports opening an assembly with a variant rule and creating a cloned assembly. This
functionality is similar to using Solution Variant from Product Configurator with the managed option or
using a Variant Rule. Cloning creates a copy of all configured and impacted assemblies. Drafts are

10. Teamcenter Integration for Solid Edge (SEEC)

10-4  newse What's New in Solid Edge 2022, Solid Edge 2022
© 2021 Siemens



included that are in the same or separate Item Revision based on the Solid Edge Option to include
drawings when revising or copying managed documents.

For more information, see General tab, Manage page (Solid Edge Options dialog box).

User help for Structure Editor is integrated with Solid Edge Help. Start with the topic, Structure Editor
overview.

Structure Editor supports cloned variants
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